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Abstrak/Abstract 

 Internet of Things (IoT) merupakan konsep yang menghubungkan objek fisik dengan 
sensor, perangkat lunak, dan teknologi lain melalui koding dan kecerdasan artifisial 
(KKA). Pemanfaatan KKA dalam hal ini tidak hanya terbatas pada otomatisasi, tetapi 
juga mencakup kemampuan membuat program melalui prompt pada fitur AI, 
sehingga mendukung pengembangan sistem yang lebih cepat dan adaptif. Konsep 
ini memiliki peluang besar dalam bidang pendidikan, khususnya pada 
pembelajaran teknik bangunan, karena membantu peserta didik memahami sistem 
penerangan dengan kontrol otomatis secara interaktif dan aplikatif. Penelitian ini 
bertujuan mengembangkan media pembelajaran Smart Building Control berbasis 
IoT yang terintegrasi dengan KKA, serta merancang model lanjutan menggunakan 
Trackbar untuk mengontrol tingkat kecerahan lampu secara fleksibel. Metode yang 
digunakan adalah Research and Development (R&D) dengan tahapan yang 
disesuaikan untuk menghasilkan produk pembelajaran yang aplikatif, inovatif, dan 
mudah diterapkan di sekolah kejuruan. Perangkat keras yang digunakan meliputi 
ESP32 Dev Kit sebagai mikrokontroler, layar OLED 1,3 inci sebagai penampil status, 
tiga LED sebagai objek kontrol, kabel jumper, dan kabel USB. Pemrograman 
dilakukan menggunakan Arduino IDE dengan dukungan library yang tersedia luas. 
Tahapan implementasi terdiri dari dua bagian, yaitu: (1) praktikum pembuatan 
media pembelajaran IoT berbasis kontrol lampu, dan (2) praktikum model lanjutan 
dengan integrasi Trackbar untuk pengaturan kecerahan lampu. Hasil penelitian 
diharapkan dapat mendorong inovasi pembelajaran berbasis teknologi, 
meningkatkan kualitas pengajaran, mengembangkan kompetensi pendidik, serta 
memperkuat hubungan antara dunia pendidikan, dunia kerja, dan dunia industri. 

The Internet of Things (IoT) is a concept that connects physical objects with sensors, software, 
and other technologies through coding and artificial intelligence (AI). The use of AI in this 
context is not only limited to automation but also includes the ability to create programs 
through prompts in AI features, thus supporting faster and more adaptive system 
development. This concept offers great opportunities in education, particularly in 
construction engineering learning, as it helps students understand lighting systems with 
automatic control in a more interactive and applicative way. This research aims to develop 
an IoT-based Smart Building Control learning media integrated with AI, as well as to design 
an advanced model using a trackbar to control lamp brightness more flexibly. The method 
employed is Research and Development (R&D), with stages adapted to produce practical, 
innovative, and easy-to-implement learning products for vocational schools. The hardware 
used includes an ESP32 Dev Kit as a microcontroller, a 1.3-inch OLED display as a status 
viewer, three LEDs as control objects, jumper wires, and a USB cable. Programming is 
carried out using Arduino IDE with the support of widely available libraries. The 
implementation stage consists of two parts: (1) practical work on developing IoT-based lamp 
control learning media, and (2) advanced practice integrating a trackbar for lamp brightness 
adjustment. The results of this research are expected to encourage innovation in technology-
based learning, improve teaching quality, enhance educator competence, and strengthen the 
linkage between education, the workplace, and industry. 

This is an open access article under the CC–BY-SA license.    
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1. Pendahuluan 

Internet of Things (IoT) merupakan konsep yang memungkinkan objek fisik 
sehari-hari dilengkapi dengan sensor, perangkat lunak, serta teknologi lain 
sehingga dapat saling terhubung dan bertukar data melalui internet (Geraldine 
et al., 2024). Pemanfaatan IoT, kecerdasan artifisial (KA), dan mahadata kini 
semakin mendominasi berbagai bidang kehidupan. Proses digitalisasi pun 
telah mengubah cara manusia bekerja, berkomunikasi, dan menyelesaikan 
masalah (Lopes et al., 2025). Dalam dunia pendidikan modern, pembelajaran 
Koding dan Kecerdasan Artifisial (KKA) menjadi kebutuhan yang esensial. KA 
menghadirkan sistem atau teknologi yang dirancang untuk meningkatkan 
mutu proses pembelajaran. Melalui penerapannya, proses belajar dapat 
dipersonalisasi sesuai kebutuhan masing-masing peserta didik. Selain 
berfungsi sebagai teknologi pendukung, pemahaman, pemanfaatan, hingga 
pengembangan KA juga dapat dijadikan sebagai materi pembelajaran di 
berbagai jenjang pendidikan. Dasar pemikiran mengenai Pembelajaran Koding 
dan Kecerdasan Artifisial ini mengacu pada Naskah Akademik Pembelajaran 
Koding dan Kecerdasan Artifisial pada Pendidikan Dasar dan Menengah, yang 
akan diuraikan lebih lanjut pada bagian berikut. 

 

 
Gambar 1. Cakupan Kecerdasan Artifisial(Pemerintah Indonesia, 2025) 

Integrasi KKA dalam dunia pendidikan tidak hanya berfungsi untuk 
meningkatkan literasi digital serta kemampuan memecahkan masalah, tetapi 
juga membekali peserta didik dengan keterampilan penting seperti berpikir 
komputasional, analisis data, algoritma pemrograman, etika kecerdasan 
artifisial, pola pikir berpusat pada manusia (human-centered mindset), 
perancangan sistem KA, hingga teknik-teknik KA. Perkembangan teknologi di 
era digital telah melahirkan beragam inovasi yang ditujukan untuk 
meningkatkan efisiensi dan kenyamanan dalam kehidupan sehari-hari. Salah 
satu inovasi yang berkembang pesat adalah sistem otomasi rumah atau Smart 
Building, yang memungkinkan pengguna mengontrol perangkat elektronik 
secara otomatis maupun dari jarak jauh (Ho et al., 2025). 

Salah satu permasalahan yang sering muncul dalam rumah tangga adalah 
pengelolaan lampu secara manual yang cenderung tidak efisien, berpotensi 
menyebabkan pemborosan energi, dan kurang praktis. Dengan adanya 
pengendalian lampu berbasis IoT, teknologi sensor, konektivitas internet, serta 
sistem otomatisasi dapat dimanfaatkan untuk mengatur sekaligus 
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mengoptimalkan penggunaan listrik (Frontera-Bergas et al., 2025). Tujuan 
utama penerapan IoT dalam pengendalian lampu adalah memberikan 
kemudahan sekaligus efisiensi sesuai kebutuhan, serta memungkinkan 
pemantauan dan pengaturan listrik dari jarak jauh menggunakan ponsel pintar 
maupun komputer. Melalui teknologi Smart Building, seluruh perangkat rumah 
tangga dapat dikendalikan hanya dengan satu smartphone berbasis Android 
(Shaharuddin et al., 2023). Beberapa penelitian terkait dengan pemanfaatan 
Modul ESP32 dan Internet of Things yang diterapkan pada bangunan di 
Indonesia. 

Tabel 1. Penelitian Terdahulu 

Peneliti dan 
Tahun 

Judul Penelitian Metode 
Penelitian 

Hasil Penelitian 

Muhammad 
Agung Raharjo, 
Fatmawati 
Sabur (2020) 

Perancangan System 
Smart Office Berbasis 
Internet of Things  
Politeknik Penerbangan 
Makassar. (Agung Raharjo 
& Sabur, 2020) 

Penelitian 
Eksperimen  

Pengujian yang dilakukan terhadap 
pengontrolan lampu, AC, Komputer dan 
Printer yang terhubung dalam sistem smart 
office dapat berfungsi dengan baik. 

Rizky Putri 
Intan Hafsari, 
Yohanes 
Sunardy Pai, 
Rahman 
Arifuddin 
(2025) 

Implementasi Kendali 
Lampu Otomatis Rumah 
Berbasis Internet of Things 
(IoT) dengan Esp32 Dan 
Blynk Melalui 
Smartphone. (Putri et al., 
2025) 

 Research and 
Development 

Alat kontrol lampu berbasis ESP32 yang dapat 
menyalakan dan mematikan lampu secara 
online melalui smartphone menggunakan 
WiFi. Sistem ini berfungsi menggantikan 
saklar manual, diprogram dengan Arduino 
IDE, dan dapat dioptimalkan untuk kontrol 
nirkabel baik melalui WiFi maupun internet. 

Joni Apriyanto, 
dkk (2024) 

Rancangan Smart Lighting 
Dengan Sensor Cahaya 
dan Gerak: Pengujian 
Desain Di Rumah Tinggal. 
(Apriyanto et al., 2024) 

Research and 
Development 

Sistem mampu mengontrol lampu secara 
otomatis sesuai kondisi ruangan, sehingga 
meningkatkan efisiensi energi. Dalam 
penerapan dunia nyata, perlu diperhatikan 
aspek teknis seperti lokasi sensor, koneksi relai 
ke saklar manual, perkabelan, catu daya, dan 
penempatan alat smart lighting untuk 
memastikan sistem bekerja optimal sesuai 
kebutuhan pengguna. 

Juan Renhard 
Okman 
Tampubolon, 
dkk (2025) 

Rancang Bangun IoT 
Otomatis Berbasis Sensor 
PIR untuk Menghemat 
Energi Listrik pada saat 
Ruangan Kosong. (Okman 
Tampubolon et al., 2025) 

Penelitian 
Eksperimen 

Sistem mampu merespons gerakan dalam ±2 
detik, mengurangi konsumsi energi hingga 
30–50% tergantung kondisi ruangan. 
Penelitian ini juga mengisi celah dari studi 
sebelumnya yang belum mengintegrasikan 
pemantauan real-time dan fitur override 
manual.  

Muhammad 
Raihan Parama 
Latief, Hariz 
Farisi, Zainul 
Abidin (2025) 

Efisiensi Konsumsi Energi 
Listrik Pada Sistem 
Pencahayaan Ruang Kelas 
Melalui Pengembangan 
Sistem Kontrol Lampu 
Ruang Kelas Berbasis 
Internet of Things dan 
Aplikasi Web. (Latief et al., 
2025) 

Research and 
Development 

sistem berhasil mengurangi konsumsi energi 
listrik secara signifikan melalui pengelolaan 
pencahayaan yang lebih efisien. Selain itu, 
aplikasi web memberikan fleksibilitas dan 
kemudahan bagi pengguna untuk memantau 
serta mengendalikan pencahayaan ruang kelas 
secara jarak jauh. 

Anggra 
Dinanda 
Ariyadi, Hani 
Zulfia Zahro, 
Joseph Dedy 
Irawan (2023) 

Prototype Penerapan 
Smart Building Berbasis 
Internet Of Thing  
(Dinanda Ariyadi et al., 
2023) 

Research and 
Development 

Prototype dapat berjalan susuai dengan yang 
diharapkan. Sensor DHT11, LDR, dapat 
mendeteksi suhu dan kelembapan sesuai 
dengan yang diharapkan dengan hasil rata-
rata error suhu 8%, kelembapan 0%, intensitas 
cahaya 63% dan diperoleh pengujian user 
berjalan sesuai dengan yang diharapkan 
dengan persentase 84% memilih setuju, 16% 
memilih netral, 0% memilih tidak setuju. 
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Peneliti dan 
Tahun 

Judul Penelitian Metode 
Penelitian 

Hasil Penelitian 

Muhammad 
Diky 
Darmawan, 
Rini Puji 
Astutik, Hendra 
Ariwianto 
(2023) 

Rancang Bangun Prototipe 
Sistem Otomatis 
Bangunan Pintar Pada 
Rumah Kos Bertingkat. 
(Darmawan et al., 2023) 

Research and 
Development 

Rancang bangun ini menghasilkan inovasi 
yang memberikan kenyamanan, efisiensi 
listrik, dan meminimalisir human error. Hasil 
uji coba menunjukkan sistem bekerja baik 
dengan tingkat error kecil (suhu 0,3% dan 
kelembaban 0,2%).  

Afunia Bundha 
Lasera, Ibnu 
Hary Wahyudi 
(2020) 

Pengembangan Prototipe 
Sistem Pengontrolan Daya 
Listrik berbasis IoT ESP32 
pada Smart Home System. 
(Lasera & Wahyudi, 2020) 

Research and 
Development 

prototipe ini mampu bekerja sesuai dengan 
perancangan dan memiliki fungsi yang 
dirancang pada tahapan identifikasi, yaitu: 
pengendalian perangkat elektronika yang 
memberikan info mati atau hidupnya 
perangkat (ON/OFF); informasi arus dan 
daya; informasi suhu lingkungan; dan 
informasi perkiraan biaya bulanan rekening 
listrik terkini. 

Muhammad 
Tegar Tirta 
Laksana, Auliya 
Rahman Isnain, 
Heni Sulistiani 
(2025) 

Penerapan Teknologi 
Aplikasi Rumah Pintar 
Berbasis Web 
Menggunakan 
Microcontroller ESP32. 
(Laksana et al., 2024) 

Research and 
Development 

Penelitian ini berhasil dikembangkan dan 
menunjukkan hasil yang positif. Aplikasi ini 
mempermudah pengguna dalam memantau 
dan mengontrol peralatan rumah tangga 
melalui antarmuka web yang responsif dan 
mudah diakses. 

    

Berdasarkan tabel di atas, dapat disimpulkan bahwa penelitian-penelitian 
tersebut menunjukkan fokus yang kuat pada pengembangan dan implementasi 
solusi praktis untuk sistem otomasi bangunan pintar (Smart Building), seperti 
kontrol pencahayaan, keamanan, dan efisiensi energi. Meskipun penelitian-
penelitian tersebut berhasil menciptakan prototipe fungsional untuk 
menghemat energi atau memberikan kenyamanan, namun memiliki 
kesenjangan utama (gap) dalam hal aplikasi pedagogis atau pendidikan. Dengan 
membuat sistem pintar untuk penggunaan langsung, penelitian dengan judul 
"Pembuatan Media Pembelajaran Smart Building Control Berbasis IoT dengan 
KKA Menggunakan ESP32" secara unik melengkapi gap yang ada dengan 
menggeser fokus dari produk komersial menjadi media pembelajaran. Penulis 
tidak hanya merancang dan membangun sistem Smart Building, tetapi juga 
mengubahnya menjadi alat bantu ajar yang membuat peserta didik memahami 
prinsip-prinsip di balik teknologi IoT dan AI. Selain itu, penelitian ini menjadi 
sebuah kontribusi orisinal (state of the art) di bidang pendidikan kejuruan dan 
pengembangan kurikulum berbasis teknologi. 

Pada umumnya, penerapan teknologi rumah pintar masih belum banyak 
dikenal ataupun digunakan secara luas dalam kehidupan sehari-hari. Inilah 
yang menjadi dasar penelitian untuk merancang sistem Smart Building dengan 
memanfaatkan konsep IoT (Urianto & Faridha, 2022). Hal tersebut menjadi 
gagasan bahwa berbagai benda di dunia nyata dapat saling terhubung dan 
berkomunikasi sebagai bagian dari satu sistem terpadu dengan memanfaatkan 
jaringan internet. Pada desain penelitian ini digunakan beberapa modul relay 
dan koneksi WiFi untuk menghubungkan perangkat ke internet serta 
menyediakan konsol aplikasi sebagai pengendali. Implementasi sistem 
dilakukan melalui miniatur rumah (maket) yang dapat dikontrol menggunakan 
smartphone Android. 

Penelitian ini berfokus pada pembuatan media pembelajaran dengan sistem 
pengendalian penerangan dengan mengatur tingkat kecerahan lampu di 
miniatur rumah menggunakan ESP32 dengan WiFi Direct sehngga dapat 
menghemat energi (Lee et al., 2023). Sistem dirancang untuk menggantikan 
fungsi saklar dengan sistem nirkabel yang dapat diakses melalui smartphone. 
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Tahapan yang dilakukan media pembelajaran ini adalah melakukan kontrol 
switch dan kontrol tingkat kecerahan lampu via web (Local Wi-Fi); dan dengan 
Tampilan OLED (Status IP Real-time). Penelitian ini diharapkan dapat 
memberikan kontribusi pada pengembangan teknologi IoT di bidang 
bangunan (Kocak & Bunyatova, 2025), khususnya dalam meningkatkan 
kenyamanan, keamanan, dan konservasi energi. Ke depan, sistem ini dapat 
dijadikan dasar pengembangan lebih lanjut, misalnya dengan menambahkan 
integrasi ke sistem keamanan tambahan atau memperluas fungsi pengendalian 
jarak jauh melalui internet (Andreas et al., 2019). 

Rumusan masalah dalam penelitian ini adalah bagaimana merancang dan 
mengembangkan media pembelajaran Smart Building Control berbasis IoT 
dengan integrasi Kecerdasan Artifisial (KKA) menggunakan ESP32 yang tidak 
hanya berfungsi sebagai sistem otomasi penerangan, tetapi juga dapat 
digunakan sebagai alat bantu ajar di pendidikan kejuruan. Pertanyaan 
penelitian yang diajukan yaitu: (1) bagaimana sistem IoT dengan ESP32 dapat 
diimplementasikan untuk mengontrol tingkat kecerahan lampu pada miniatur 
rumah melalui WiFi Direct dan web server, serta (2) sejauh mana media 
pembelajaran ini mampu meningkatkan pemahaman peserta didik terhadap 
prinsip kerja teknologi IoT dan AI dalam konteks bangunan pintar. 

2. Metodologi 

2.1.  Metode Penelitian 
Penelitian ini mengadopsi metode Research and Development (R&D) untuk 

mengembangkan sebuah media pembelajaran, yaitu Smart Building Control 
yang terintegrasi dengan teknologi IoT dan dikendalikan menggunakan ESP32. 
Tahapan R&D dalam penelitian ini meliputi studi pendahuluan untuk 
menganalisis kebutuhan dan potensi produk, perancangan produk berupa 
Smart Building Control, pengembangan sistem IoT dan program 
mikrokontroler ESP32, serta validasi ahli dan uji coba produk untuk 
memastikan kelayakan dan efektivitasnya sebagai media pembelajaran.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 2. Langkah-Langkah Penelitian 
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 Pada tahap awal, peneliti melakukan identifikasi masalah dan meninjau 
berbagai referensi dari penelitian sebelumnya. Kemudian, pada tahap kedua, 
peneliti mengumpulkan data yang relevan dari hasil identifikasi tersebut, lalu 
menganalisisnya untuk menentukan kebutuhan penelitian. Selanjutnya, pada 
tahap ketiga, peneliti mulai merancang prototipe produk berdasarkan analisis 
yang telah dilakukan. Tahap keempat adalah validasi desain, di mana 
rancangan produk dinilai kelayakannya. Apabila terdapat masukan atau saran 
perbaikan, maka pada tahap kelima akan dilakukan revisi untuk menghasilkan 
produk yang lebih berkualitas dan berfungsi secara optimal. Dan terakhir, 
tahap keenam adalah uji coba produk untuk memastikan hasil rancangan dapat 
berfungsi dengan baik dan sesuai harapan. 

2.2. Perangkat Keras dan Lunak 
Pembuatan media pembelajaran Smart Building Control Berbasis IoT dengan 

KKA Menggunakan ESP32 ini memerlukan dukungan perangkat keras dan 
perangkat lunak, diantaranya sebagai berikut: 

Tabel 2. Perangkat Keras 

Gambar Nama Deskripsi 

 

ESP-WROOM32 
ESP32 ESP 32S 

Modul resmi dari Espressif yang berisi chip ESP32, 
memori, dan antena terintegrasi, siap pakai. (Lim 
et al., 2024) 

 

Modul display OLED 
1.3 inci I2C 

modul display OLED 1.3 inci dengan  koneksi I2C. 
OLED lebih unggul dari LCD karena setiap 
pikselnya memancarkan  cahaya sendiri, 
menghasilkan kontras tajam dan hitam pekat. 
Dengan resolusi umumnya 128x64 piksel dan 
hanya butuh dua kabel data (SDA & SCL) 

 

ESP32 Expansion 
Board 

Papan sirkuit cetak (PCB) yang dirancang untuk 
mempermudah penggunaan modul ESP32 
(seperti ESP-WROOM-32) dengan menyediakan 
akses yang lebih mudah ke pin-pinnya dan 
menambah fungsionalitas lain. 

 

Miniatur Rumah 
(maket) 

Miniatur rumah (maket) sebagai representasi 
rumah yang akan dijadikan media pembelajaran 
untuk dikontrol secara IoT. 

 

Kabel Data USB A ke 
Micro-B 

Untuk menghubungkan ESP32 ke komputer dan 
mengunggah program. 

 

Kabel Jumper Untuk menghubungkan ESP32 ke modul relay dan 
komponen lainnya. 
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Gambar Nama Deskripsi 

 

Resisitor 220 Ohm Resistor 220 Ohm adalah komponen pasif 
elektronik yang berfungsi untuk menghambat atau 
membatasi arus listrik dalam sebuah rangkaian. 
Nilai hambatannya sebesar 220 Ohm (Ω). 

 

Lampu LED Lampu LED (Light Emitting Diode) adalah 
komponen elektronik yang menghasilkan cahaya 
ketika arus listrik melewatinya. Dibandingkan 
dengan lampu pijar konvensional, LED jauh lebih 
efisien dalam hal konsumsi energi. 

 

Penulis menggunakan Arduino IDE sebagai perangkat lunak utama untuk 
pemrograman, karena kemudahannya dalam penulisan, kompilasi, dan 
pengunggahan kode ke mikrokontroler ESP32. Pilihan ini didasari oleh 
antarmuka yang sederhana dan komunitas yang besar, yang sangat membantu 
dalam proses pengembangan (Nizam et al., 2022). Melalui Arduino IDE, semua 
perintah dan logika kendali untuk sistem IoT, termasuk komunikasi data dan 
aktivasi komponen, dapat diatur secara efisien. 

2.3. Rangkaian Sistem dan Flowchart 
Dalam pengembangan suatu sistem, perencanaan menjadi langkah krusial 

untuk menyederhanakan dan mengarahkan proses perancangan alat. Agar alur 
kerja dari sistem yang akan dibuat dapat dipahami dengan mudah, perlu dibuat 
sebuah konsep rangkaian sistem yang divisualisasikan melalui simulasi. 

 

Gambar 4. Rangkaian Sistem Media Pembelajaran 

 Gambar di atas merupakan diagram wiring sistem kendali lampu berbasis 
ESP32 yang terintegrasi dengan beberapa modul eksternal, yaitu tiga sensor 
cahaya (representasi Trackbar) sebagai input kondisi lingkungan, modul RTC 
DS3231 sebagai pencatat waktu nyata, modul relay 4 channel sebagai aktuator 
untuk menyalakan atau mematikan lampu, serta OLED 1.3” sebagai media 
tampilan informasi. Sensor cahaya dihubungkan ke pin analog ESP32 untuk 
membaca intensitas cahaya, sedangkan RTC dan OLED menggunakan 
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komunikasi I2C melalui jalur SDA dan SCL yang sama dengan suplai VCC dan 
GND. Modul relay mendapat sinyal kendali dari pin digital ESP32 dan 
berfungsi sebagai saklar elektronik untuk mengatur nyala lampu berdasarkan 
perintah yang diproses oleh ESP32 (Romadlon Ardliyansyah & Bachri, 2022). 
Secara keseluruhan, rangkaian ini memungkinkan ESP32 untuk membaca 
kondisi cahaya dan waktu, kemudian mengendalikan lampu secara otomatis 
atau manual, sekaligus menampilkan status sistem melalui layar OLED 
(Gunawan et al., 2025). 

 

Gambar 5. Flowchart Sistem 

 Diagram alir di atas menggambarkan proses kerja sistem Smart Building 
Control berbasis ESP32 yang terintegrasi dengan OLED 1.3”, web server, PWM, 
dan RTC (Real Time Clock). Alur dimulai dari inisialisasi ESP32 yang terhubung 
ke adaptor dan WiFi lokal, kemudian OLED menampilkan IP konfigurasi 
untuk diakses melalui browser (Easterline et al., 2024). Setelah web terhubung, 
pengguna dapat menyalakan dan mengatur intensitas lampu menggunakan 
tombol dan Trackbar, dimulai dari Lampu 1, Lampu 2, hingga Lampu 3. Sistem 
kemudian memverifikasi kesesuaian nilai PWM dari semua lampu dan 
menampilkan data RTC berupa waktu dan tanggal. RTC juga berfungsi sebagai 
pengatur otomatis lampu dengan jadwal hidup pukul 18.00 dan mati pukul 
05.00. Jika seluruh integrasi web button, Trackbar, date, dan time berjalan 
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sesuai, maka webserver akan menampilkan kondisi yang diinginkan, 
sedangkan jika terjadi ketidaksesuaian data atau error, sistem meminta reload 
halaman web untuk sinkronisasi ulang (Zakaria et al., 2023). Dengan demikian, 
sistem ini menggabungkan kontrol manual melalui web dengan kontrol 
otomatis berbasis waktu untuk meningkatkan efisiensi dan kepraktisan 
pengendalian lampu (El-Khozondar et al., 2024). 

3.Hasil dan Pembahasan 

Setelah melalui tahapan perancangan rangakaian sistem dan penyusunan 
flowchart untuk media pembelajaran Smart Building control menggunakan WiFi 
dengan ESP32, maka langkah selanjutnya adalah menjelaskan hasil 
penggunaan media pembelajaran tersebut dengan tahapan yaitu: melakukan 
kontrol lampu via web (Local WiFi); dan melakuan kontrol melalui Trackbar 
untuk mengatur kecerahan lampu via web. Berikut adalah hasil dan 
pembahasan dari setiap aspek pengujian yang dilakukan. 

3.1. Kontrol Relay Via Web (Local Wi-Fi) 
Pada tahap ini, peserta pelatihan melakukan Instalasi Arduino IDE dengan 

beberapa tahapan sebagai berikut: 
a. Download Arduino IDE 

1) Membuka https://www.arduino.cc/en/software 
2) Memilih sesuai sistem operasi (Windows, macOS, Linux) 
3) Meng-Install dengan mengikuti wizard yang tersedia. 

b. Menambahkan Board ESP32 ke Arduino IDE 
1) Membuka Arduino IDE → File → Preferences 
2) Pada kolom Additional Boards Manager URLs, masukkan: 

https://dl.espressif.com/dl/package_esp32_index.json 
3) Klik OK. 
4) Membuka Tools → Board → Board Manager 
5) Mencari esp32 by Espressif Systems, lalu klik Install. 

c. Memilih Board ESP32 
1) Membuka Tools → Board → ESP32 Arduino → ESP32 Dev Module. 
2) Pada Tools → Port, pilih port COM sesuai dengan ESP32 yang terhubung.  

Langkah selanjutnya adalah menginstalasi Library yang dibutuhkan untuk 
dapat membuat program dengan tahapan dibawah ini: 
a. Memasukkan Library Adafruit GFX dan SH110X (OLED) 

1) Membuka Tools → Manage Libraries. 
2) Mencari Adafruit GFX Library, lalu klik Install. 
3) Mencari Adafruit SH110X dan SSD1306, lalu klik Install. 

b. Library WiFi dan WebServer. Sudah tersedia secara default setelah 
menginstall board ESP32. 

Berikutnya adalah membuat rangkaian wiring system dengan ketentuan 
sebagai berikut: 

 



344 
 
 

a. Wiring OLED ke ESP32 (I2C) 
1) VCC → 3.3V 
2) GND → GND 
3) SDA → GPIO21 
4) SCL → GPIO22 

b. Wiring Lampu/LED ke ESP32 
1) Lampu 1 → GPIO32 
2) Lampu 2 → GPIO26 
3) Lampu 3 → GPIO25 
4) Relay 1 → GPIO34 
5) Relay 2 → GPIO24 
6) Relay 3 → GPIO23 

Selanjutnya adalah membuat program dasar ESP32 dengan LED dan Web 
Control dengan program dibawah ini: 

  

 
 

Gambar 6. Program Kontrol Lampu/LED via Web 

 Selanjutnya adalah meng-upload program tersebut ke ESP32 dengan 
langkah-langkah sebagai berikut: 

1) Menghubungkan ESP32 ke laptop via USB. 
2) Memilih board ESP32 Dev Module di Arduino IDE. 
3) Memilih port COM yang sesuai. 
4) Klik tombol Upload (panah kanan). 
5) Menunggu hingga muncul pesan Done Uploading. 
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Terakhir yaitu melakukan uji coba tampilan melalui web berdasarkan 
program yang sudah diupload, dengan langkah-langkah sebagai berikut: 

1) Setelah upload berhasil, OLED akan menampilkan alamat IP. 
2) Membuka browser (Chrome/Edge/Firefox). 
3) Ketik alamat IP yang tampil di OLED. 
4) Akan muncul halaman kontrol dengan 3 tombol untuk menyalakan dan 

mematikan lampu. 

3.2. Kontrol Trackbar untuk Mengatur Tingkat Kecerahan Lampu 
 Bagian ini merupakan puncak dari seluruh materi yang telah dipelajari. 

Peserta akan menerapkan semua pengetahuan dan keterampilan, mulai dari 
perancangan maket, perakitan komponen elektronika, hingga pemrograman, 
untuk menciptakan sebuah karya nyata. Proyek akhir ini bertujuan untuk 
mengukur kemampuan peserta diantaranya dapat: 

a) Menerjemahkan konsep maket ke dalam bentuk fisik. 
b) Mengintegrasikan sistem elektronika (ESP32) dan pemrograman ke dalam 

maket. 
c) Menyelesaikan masalah teknis yang mungkin muncul selama proses 

perakitan dan pengujian. 
d) Menghasilkan produk akhir yang fungsional, rapi, dan sesuai dengan 

kriteria yang ditentukan. 

Berikut adalah program untuk menyalakan LED internal pada kontrol 
Trackbar untuk mengatur tingkat kecerahan lampu: 
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Gambar 6. Program Kontrol Trackbar untuk Mengatur Tingkat Kecerahan 

Lampu OLED 

Setiap peserta atau kelompok akan membuat sebuah maket miniatur 
bangunan (misalnya, rumah, caffe, atau gedung sederhana). Maket ini harus 
memiliki sistem penerangan internal (lampu LED) yang dapat dikontrol secara 
nirkabel melalui web server yang dijalankan oleh ESP32 dengan kriteria proyek 
sebagai berikut: 

a) Maket Fisik: Maket harus dibuat dengan rapi, proporsional, dan memiliki 
detail yang memadai. 

b) Fungsi Elektronika: Semua lampu LED harus berfungsi dan dapat 
dikontrol dari halaman web. 

c) Program: Program harus stabil, tidak mengalami crash, dan halaman web 
dapat diakses dengan mudah. 

d) Presentasi: Peserta diharapkan dapat mempresentasikan maket dan 
menjelaskan alur kerja programnya. 
 

3.3. Tampilan Media Pembelajaran dan Web Server 

Penelitian ini menghasilkan sebuah media pembelajaran yang inovatif, 
tidak hanya dalam wujud fisik, tetapi juga dalam fungsionalitasnya yang 
terintegrasi dengan teknologi modern.  
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Gambar 7. Tampilan Fisik Media Pembelajaran 

Mengacu pada gambar di atas, media pembelajaran yang dikembangkan 
menampilkan wujud perangkat elektronik yang dipadukan secara teratur 
dalam sebuah maket rumah. Di dalam maket tersebut tersusun berbagai 
komponen elektronika yang memiliki fungsi masing-masing, dengan 
mikrokontroler sebagai pengendali utama dan elemen pendukung lain yang 
saling berhubungan. Rancangan ini tidak hanya berperan melindungi 
rangkaian, tetapi juga memberikan visualisasi yang jelas sehingga 
memudahkan pembelajaran mengenai susunan serta keterkaitan antar 
komponen elektronik dalam sebuah sistem terintegrasi. 

 

Gambar 8. Tampilan Fisik Media Pembelajaran 

Gambar di atas menunjukkan tampilan antarmuka web dari media 
pembelajaran Smart Building Control berbasis IoT dengan KKA menggunakan 
ESP32. Pada halaman tersebut terlihat tiga kontrol utama berupa slider untuk 
mengatur intensitas pencahayaan pada Lampu Taman, Lampu Teras, dan 
Lampu Ruangan secara real-time. Desain antarmuka dibuat sederhana namun 
interaktif, sehingga memudahkan pengguna dalam memahami cara kerja 
sistem kendali otomatis berbasis Internet of Things (IoT) (Alam et al., 2024). 
Informasi waktu yang ditampilkan di bagian bawah halaman juga menambah 
fungsi sebagai penunjuk aktivitas sistem secara kontekstual. Tampilan ini 
memperlihatkan keterhubungan antara ESP32 dengan web server yang 
mendukung konsep Komputasi, Komunikasi, dan Automasi dalam 
pembelajaran, sehingga peserta didik dapat lebih mudah mempelajari prinsip 
kerja Smart Building berbasis teknologi modern. 
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3.4. Refleksi R&D dalam Pengembangan Media Pembelajaran 

Pengembangan media pembelajaran Smart Building Control berbasis IoT 
dengan KKA ini dilaksanakan menggunakan metode Research and 
Development (R&D) yang terdiri dari beberapa tahapan utama. Setiap tahapan 
tidak hanya berorientasi pada hasil produk teknis, tetapi juga menekankan 
aspek kelayakan, efektivitas, serta relevansi dalam konteks pendidikan vokasi. 
Pada tahap awal, peneliti melakukan analisis kebutuhan dengan meninjau 
literatur terkait penelitian sebelumnya serta memetakan potensi penerapan 
IoT dalam dunia pendidikan. Hasil studi ini menunjukkan adanya kesenjangan 
antara penelitian Smart Building yang berfokus pada prototipe teknis dengan 
kebutuhan media pembelajaran. Oleh karena itu, sistem yang dikembangkan 
diarahkan untuk menjembatani gap tersebut, yaitu dari sekadar otomasi rumah 
pintar menjadi alat bantu ajar interaktif. 

Tahap selanjutnya adalah merancang produk Smart Building Control yang 
terintegrasi dengan ESP32. Perancangan mencakup desain rangkaian 
elektronik, penyusunan skema wiring, dan pembuatan maket miniatur rumah 
sebagai representasi nyata lingkungan bangunan pintar. Desain juga 
memasukkan elemen pedagogis, seperti tampilan OLED untuk 
memvisualisasikan status sistem dan antarmuka web server yang sederhana 
namun edukatif. Setelah perancangan selesai, tahap pengembangan dilakukan 
dengan menulis program mikrokontroler menggunakan Arduino IDE. 
Implementasi meliputi integrasi modul WiFi untuk kontrol via web server, 
pengaturan intensitas lampu dengan PWM melalui trackbar, serta 
penambahan tampilan status real-time di OLED. Tahap ini sekaligus menguji 
stabilitas sistem, kesesuaian logika pemrograman, dan keterhubungan antar 
modul.  

Produk yang dikembangkan selanjutnya divalidasi oleh para Widyaiswara 
di bidang teknik bangunan. Validasi mencakup aspek fungsionalitas (apakah 
sistem berjalan sesuai rancangan), kepraktisan (apakah mudah dioperasikan 
dalam konteks pembelajaran), dan pedagogis (apakah sesuai untuk mendukung 
capaian pembelajaran teknik bangunan). Saran perbaikan dari validator 
dijadikan masukan untuk penyempurnaan sistem. Tahap terakhir adalah uji 
coba melalui implementasi maket miniatur rumah yang dilengkapi sistem 
penerangan berbasis IoT. Uji coba dilakukan dengan mengontrol lampu 
melalui web server lokal dan trackbar untuk pengaturan intensitas cahaya. 
Hasil uji coba menunjukkan bahwa sistem dapat bekerja stabil, responsif, serta 
mudah dipahami oleh peserta didik. Secara keseluruhan, rangkaian tahapan 
R&D ini memastikan bahwa media pembelajaran yang dihasilkan tidak hanya 
sebatas prototipe fungsional, tetapi juga memiliki nilai aplikatif, edukatif, dan 
inovatif. Dengan demikian, penelitian ini memberikan kontribusi nyata dalam 
pengembangan media pembelajaran berbasis teknologi modern yang relevan 
dengan kebutuhan dunia pendidikan vokasi, sekaligus mendukung 
keterampilan abad 21 seperti literasi digital, pemrograman, dan pemahaman 
sistem IoT. 



349 
 

 

4. Kesimpulan & Saran 

4.1. Kesimpulan  

Media Pembelajaran ini dirancang untuk melakukan pengendalian 
penerangan dengan mengatur tingkat kecerahan lampu di miniatur rumah 
menggunakan ESP32 dengan WiFi Direct sehngga dapat menghemat energi 
listrik. Tahapan yang dilakukan media pembelajaran ini adalah melakukan 
kontrol switch dan kontrol tingkat kecerahan lampu via web (Local Wi-Fi); dan 
dengan Tampilan OLED (Status IP Real-time). Penelitian ini diharapkan dapat 
memberikan kontribusi pada pengembangan teknologi IoT di bidang 
bangunan, khususnya dalam meningkatkan kenyamanan, keamanan, dan 
konservasi energi. Ke depan, sistem ini dapat dijadikan dasar pengembangan 
lebih lanjut, misalnya dengan menambahkan integrasi ke sistem keamanan 
tambahan atau memperluas fungsi pengendalian jarak jauh melalui internet.  

4.2. Saran  

Disarankan agar pengembangan selanjutnya dapat mencakup penambahan 
fitur otomatisasi melalui sensor lingkungan seperti cahaya, suhu, maupun 
gerak, sehingga sistem tidak hanya dapat dikendalikan secara manual tetapi 
juga mampu merespons kondisi sekitar secara mandiri. Selain itu, antarmuka 
web perlu ditingkatkan agar lebih interaktif, responsif, dan dilengkapi dengan 
dashboard monitoring yang menampilkan status perangkat dalam bentuk 
grafik maupun indikator visual yang informatif. Integrasi dengan platform IoT 
berbasis cloud juga penting dilakukan agar kontrol dan pemantauan dapat 
diakses dari jarak jauh melalui internet, didukung dengan penerapan 
keamanan data melalui autentikasi pengguna dan enkripsi komunikasi. Dari 
sisi media pembelajaran, perlu adanya modul penunjang serta maket rumah 
mini untuk mempermudah pemahaman konsep Smart Building berbasis IoT, 
yang kemudian diuji coba dalam lingkungan belajar nyata untuk menilai 
efektivitas dan mendapatkan umpan balik dari pengguna dalam rangka 
penyempurnaan sistem. 
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